Cisco ICM Software WebView Installation Guide

ICM Software Version 5.0

Corporate Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
800 553-NETS (6387)
Fax: 408 526-4100

Customer Order Number:
Text Part Number: OL-0730-04
THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT
NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT
ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR
THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE
INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU
ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A
COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as
part of UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE
PROVIDED “AS IS” WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED
OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL
DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR
INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

CCIP, CCSP, the Cisco Arrow logo, the Cisco Powered Network mark, the Cisco Systems Verified logo, Cisco Unity, Follow
Me Browsing, FormShare, iQ Breakthrough, iQ FastTrack, the iQ Logo, iQ Net Readiness Scorecard, Networking
Academy, ScriptShare, SMARTnet, TransPath, and Voice LAN are trademarks of Cisco Systems, Inc.; Changing the Way
We Work, Live, Play, and Learn, The Fastest Way to Increase Your Internet Quotient, and iQuick Study are service
marks of Cisco Systems, Inc.; and Aironet, ASIST, BPX, Catalyst, CCDA, CCDP, CCIE, CCNA, CCNP, Cisco, the Cisco
Certified Internetwork Expert logo, Cisco IOS, the Cisco IOS logo, Cisco Press, Cisco Systems, Cisco Systems Capital,
the Cisco Systems logo, Empowering the Internet Generation, Enterprise/Solver, EtherChannel, EtherSwitch, Fast Step,
GigaStack, Internet Quotient, IOS, IP/TV, iQ Expertise, LightStream, MGX, MICA, the Networkers logo, Network
Registrar, Packet, PIX, Post-Routing, Pre-Routing, RateMUX, Registrar, SlideCast, StrataView Plus, Stratm,
SwitchProbe, TeleRouter, and VCO are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and
certain other countries.

All other trademarks mentioned in this document or Web site are the property of their respective owners. The use of
the word partner does not imply a partnership relationship between Cisco and any other company. (0301R)

Cisco ICM Software Web View Installation Guide
Copyright © 2000–2003, Cisco Systems, Inc.
All rights reserved.
About This Guide vii
   Objective vii
   Audience vii
   Organization viii
   Conventions ix
   Related Publications ix
   Other Publications x

Obtaining Documentation xi
   World Wide Web xi
   Documentation CD-ROM xi
   Ordering Documentation xi
   Documentation Feedback xii

Obtaining Technical Assistance xii
   Cisco.com xii
   Technical Assistance Center xiii
      Contacting TAC by Using the Cisco TAC Website xiii
      Contacting TAC by Telephone xiv

CHAPTER 1 WebView System Requirements 1-1
   Overview 1-1
   The WebView System 1-1
   Client System Sizing for ICM 5.0 1-2
CHAPTER 2

Installation Requirements 2-1

Overview 2-1
Cisco ICM WebView Software AW Requirements 2-2
System Requirements 2-2
Upgrading from a Previous Version of Cisco ICM WebView Software 2-3
Third-Party Software Requirements 2-4
Third-Party Software Licenses 2-5
Supported Languages and Character Set 2-6
Installing a Supported Web Browser 2-6
Updating Your Browser’s Cache 2-7
Internet Explorer, version 5.5, SP2 and version 6.0 2-7
Installing Windows 2000 Service Pack 3 2-7
Installing the WebView Third-Party CD Software 2-8
Changing the Jaguar Admin Password 2-11
Setting the Size of the Jaguar Log File 2-13
Deleting Jaguar Log Files 2-14
Uninstalling the Third Party Software 2-14

CHAPTER 3

Installing Cisco ICM WebView Software and Setting Up Users 3-1

Overview 3-1
Installing Cisco ICM WebView Software 3-2
Installing WebView for ICM Instances and for Customers 3-3
Creating a WebView Administrator 3-4
Testing (Logging into) Your WebView Installation  3-6
Troubleshooting Your WebView Installation  3-7
Enabling, Adding, and Maintaining ICM Agents  3-7
   Enabling Agent Data  3-8
   Adding and Maintaining ICM Agents  3-9
      Setting Up Agents  3-9
Assigning an Agent to be a Supervisor  3-10
Setting Up WebView Users  3-12

APPENDIX A
Upgrading From a Previous Version of ICM WebView  A-1
   Differences between ICM WebView 4.6.2 and ICM WebView 5.0  A-2
      Templates that have been deleted and replaced by templates in the same
      reporting category  A-2
      Templates that were deleted and replaced by templates in different reporting
      categories  A-5
   How to view saved report files that were not migrated to the WebView
      database  A-6
   Templates that were deleted and not replaced  A-7

APPENDIX B
Troubleshooting Tips  B-1
   Tip Organization  B-1
   Overview  B-1
   Troubleshooting by following the call flow  B-2
      The information Call Flow in Figure B-1 Described  B-2
   Graphical Reports and the Job Scheduler:
      Incorrect display and improper function  B-4
   Third-Party Software Installation Error Message:
      IIS Admin Service not correctly configured  B-5
   World Wide Publishing Service:
      Stopping it and restarting WebView  B-6
Contents

Java code displayed on opening Webview B-7
Error message on attempting to select a WebView template B-7
Error message after changing the Jaguar Admin Password B-8
Saving time when creating large or many historical reports B-8
WebView-Only User Unable to Change Password B-9
About This Guide

Objective

This manual describes how to use Cisco Intelligent Contact Management (ICM) software to install and maintain the Cisco ICM software WebView product. It includes installation information for the third-party software that WebView requires.

Audience

This document is intended for Cisco ICM WebView administrators. The administrator should have a general understanding of contact center operations and management and specific information about the contact centers and carrier networks connected to Cisco ICM software. The administrator should also have a good understanding of Windows 2000.
Organization

The manual is divided into the following sections.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, “WebView System Requirements”</td>
<td>The WebView system requirements of servers and clients.</td>
</tr>
<tr>
<td>Chapter 2, “Installation Requirements”</td>
<td>The software and hardware installation requirements</td>
</tr>
<tr>
<td>Chapter 3, “Installing Cisco ICM WebView Software and Setting Up Users”</td>
<td>How to install WebView software on your server and how to set up your WebView end-users</td>
</tr>
<tr>
<td>Appendix A, “Upgrading From a Previous Version of ICM WebView”</td>
<td>ICM 4.6.2 report templates not in ICM 5.0 and the templates that replaced them</td>
</tr>
<tr>
<td>Appendix B, “Troubleshooting Tips”</td>
<td>WebView installation troubleshooting tips not included in Chapter 3.</td>
</tr>
</tbody>
</table>
Conventions

This manual uses the following conventions.

<table>
<thead>
<tr>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boldface type is used for user entries, keys, buttons, and folder and submenu names.</td>
<td>Click Next.</td>
</tr>
<tr>
<td>Italic type indicates one of the following:</td>
<td>A skill group is a collection of agents who share similar skills.</td>
</tr>
<tr>
<td>• A newly introduced term</td>
<td>• Do not use the numerical naming convention that is used in the predefined templates (for example, persvc01).</td>
</tr>
<tr>
<td>• For emphasis</td>
<td>• IF (condition, true-value, false-value)</td>
</tr>
<tr>
<td>• A generic syntax item that you must replace with a specific value</td>
<td>• For more information, see the Cisco ICM Software Database Schema Handbook.</td>
</tr>
<tr>
<td>• A title of a publication</td>
<td></td>
</tr>
<tr>
<td>An arrow (&gt;) indicates an item from a pull-down menu.</td>
<td>The Save command from the File menu is referenced as File &gt; Save.</td>
</tr>
</tbody>
</table>

Related Publications

Cisco ICM Software Configuration Guide

Describes how to use the Configuration Manager to configure an ICM contact center.

For specific information on an ACD or NIC, see the appropriate Cisco ICM software ACD or NIC supplement documentation or ask your customer representative for that documentation.

Cisco ICM Software Custom Screen Builder Tutorial

Describes how to use ICM Custom Screen Builder to create custom report templates and provides instructions on how to launch these templates using WebView.
Cisco ICM Software Installation Guide
Describes how to install the components of ICM software, including information about hardware configuration and software setup.

Cisco ICM Software IPCC Administration Guide
Describes tasks and concepts required for day-to-day operation of an IPCC contact center. This guide includes information for multichannel options as well as voice.

Cisco ICM Software: IPCC Installation and Configuration Guide
Describes how to install and configure the ICM components that are used for the Cisco IP Contact Center (IPCC) solution. This manual includes installation and configuration instructions for the ICM components used in an IPCC solution. It also includes information on configuration requirements for other IPCC components that interface with the ICM software, including the Cisco CallManager, Cisco IP-IVR and Cisco Agent Desktop/Cisco Supervisor Desktop.

Cisco ICM Software IPCC Reporting Guide
Describes IPCC reporting architecture, operations, and data and explains how to meet reporting needs.

Cisco ICM Software WebView User Guide
Describes report categories, templates, and features available in ICM software WebView and WebView for E-Mail Manager.

Other Publications

For additional information about Cisco Intelligent Contact Management (ICM) software, see the Cisco web site listing ICM documentation.
Obtaining Documentation

The following sections provide sources for obtaining documentation from Cisco Systems.

World Wide Web

You can access the most current Cisco documentation on the World Wide Web at the following sites:

- http://www.cisco.com
- http://www-china.cisco.com
- http://www-europe.cisco.com

Documentation CD-ROM

Cisco documentation and additional literature are available in a CD-ROM package, which ships with your product. The Documentation CD-ROM is updated monthly and may be more current than printed documentation. The CD-ROM package is available as a single unit or as an annual subscription.

Ordering Documentation

Cisco documentation is available in the following ways:

- Registered Cisco Direct Customers can order Cisco Product documentation from the Networking Products MarketPlace:
  http://www.cisco.com/cgi-bin/order/order_root.pl
- Registered Cisco.com users can order the Documentation CD-ROM through the online Subscription Store:
  http://www.cisco.com/go/subscription
- Nonregistered Cisco.com users can order documentation through a local account representative by calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, in North America, by calling 800 553-NETS(6387).
Documentation Feedback

If you are reading Cisco product documentation on the World Wide Web, you can submit technical comments electronically. Click Feedback in the toolbar and select Documentation. After you complete the form, click Submit to send it to Cisco.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front cover of your document, or write to the following address:

Attn Document Resource Connection
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance

Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partners can obtain documentation, troubleshooting tips, and sample configurations from online tools. For Cisco.com registered users, additional troubleshooting tools are available from the TAC website.

Cisco.com

Cisco.com is the foundation of a suite of interactive, networked services that provides immediate, open access to Cisco information and resources at anytime, from anywhere in the world. This highly integrated Internet application is a powerful, easy-to-use tool for doing business with Cisco.

Cisco.com provides a broad range of features and services to help customers and partners streamline business processes and improve productivity. Through Cisco.com, you can find information about Cisco and our networking solutions, services, and programs. In addition, you can resolve technical issues with online technical support, download and test software packages, and order Cisco learning materials and merchandise. Valuable online skill assessment, training, and certification programs are also available.
Customers and partners can self-register on Cisco.com to obtain additional personalized information and services. Registered users can order products, check on the status of an order, access technical support, and view benefits specific to their relationships with Cisco.

To access Cisco.com, go to the following website:

http://www.cisco.com

Technical Assistance Center

The Cisco TAC website is available to all customers who need technical assistance with a Cisco product or technology that is under warranty or covered by a maintenance contract.

Contacting TAC by Using the Cisco TAC Website

If you have a priority level 3 (P3) or priority level 4 (P4) problem, contact TAC by going to the TAC website:

http://www.cisco.com/tac

P3 and P4 level problems are defined as follows:

- P3—Your network performance is degraded. Network functionality is noticeably impaired, but most business operations continue.
- P4—You need information or assistance on Cisco product capabilities, product installation, or basic product configuration.

In each of the above cases, use the Cisco TAC website to quickly find answers to your questions.

To register for Cisco.com, go to the following website:

http://www.cisco.com/register/

If you cannot resolve your technical issue by using the TAC online resources, Cisco.com registered users can open a case online by using the TAC Case Open tool at the following website:

http://www.cisco.com/tac/caseopen
Contacting TAC by Telephone

If you have a priority level 1 (P1) or priority level 2 (P2) problem, contact TAC by telephone and immediately open a case. To obtain a directory of toll-free numbers for your country, go to the following website:


P1 and P2 level problems are defined as follows:

- **P1**—Your production network is down, causing a critical impact to business operations if service is not restored quickly. No workaround is available.
- **P2**—Your production network is severely degraded, affecting significant aspects of your business operations. No workaround is available.
WebView System Requirements

Overview

This chapter contains the following topics:

- The WebView System
- Client System Sizing for ICM 5.0
- Server System Sizing and Scaling for ICM 5.0

The WebView System

WebView is a two-tier client/server reporting query and presentation product. A set of at least one WebView servers support a number of clients:

- The WebView client is simply a Windows-based PC or workstation running a web browser. (Unix based clients are neither qualified nor supported yet, though, by design are not precluded.)
- The WebView server is an ICM Admin Workstation running MS Windows 2000 Server and IIS 5.0 with WebView installed. The WebView server may or may not also be a Historical Database Server.
Client System Sizing for ICM 5.0

- Windows 2000
- Internet Explorer, version 5.5 SP2 or 6.0
- 200 MHZ CPU
- 64M RAM
- 1G disk

Server System Sizing and Scaling for ICM 5.0

Server sizing and scaling is less straightforward. Small single-site contact center ICM installations may demand little of the WebView server, and it can co-reside with other components.

For large or highly distributed installations with many WebView clients and/or with large historical databases, it is necessary to have multiple dedicated server-class WebView servers installed on dedicated ICM Historical Database Servers.

Exact sizing requirements are dependent on your database and system usage.

Server Hardware Guidelines

- Windows 2000 Server (ICM 5.0)
- >650 MHz CPU
- 2G RAM
- 40G disk (non HDS)
- HDS disk sizing dependent on DB archive requirements.
- CD ROM drive
Server Use Guidelines

- Use the Job Scheduler to schedule historical reports, especially reports with lots of data, to be run at night time or at times when you do not require real-time reports.
- If you have many historical reports to repeatedly run, you might consider assigning a WebView server to run only historical reports while another WebView server runs only real-time reports. That way the historical reports will not delay the running of your real-time reports.

The simplest way to separate the servers is to ask the users to use one URL for real-time reports and other for historical reports. So that users can see only those templates that should be run on a server, you can also delete the real-time templates on one WebView server (using the Custom Screen Builder), and delete the historical templates on the other server.

General Scaling Guidelines

Scenario 1. Test bed, lab or very small single-site market: less than 50 agents.

If an installation is single-site, Call Termination or Route Details are not required, and there are 3 or less simultaneous WebView clients, then the ICM Admin Workstation, WebView server and Logger can all reside on the same system. See the Cisco ICM Software Administrator Guide for system sizing requirements, but, for simple test/lab cases, systems somewhat smaller than the administrator guide requirements may often suffice.


If an installation is single-site, with less than 10 Meg of Call Termination or Route Detail records and less than 10 WebView clients, the WebView server can reside on the primary ICM Administrative Workstation.

If there are more than 10 simultaneous WebView clients, a separate WebView server/Admin Workstation is recommended. This WebView server can be associated with a standalone ICM Administrative Workstation. Additionally, a separate ICM Historical Database Server, or HDS is required if custom reports based on Call Termination or Route Details are required, or more than 20M records of historical data are kept.

Scenario 4. Medium-Large Enterprise Markets. greater than 500 agents, greater than 50 WebView clients.

If there are more than 50 simultaneous WebView clients, one WebView server for each set of 50 clients is recommended.

Note
As larger loads are qualified, this number will increase. Therefore, the hardware sizing listed below is based on scalability to larger loads.

Scenario 5. Large Service Provider Markets: less than 500 agents, multiple customer ICM instances, and less than 50 WebView clients.

If there are multiple CICM instances, each CICM must have a dedicated HDS. If there are more than 50 clients for each CICM, then an additional WebView Server AW for each set of 50 CICM clients is recommended. The HDS can function as a WebView server. In most cases, additional WebView Servers can be simple AW's and be installed to redirect to the CICM HDS. In the most strenuous load cases, an HDS should be dedicated to each WebView Server.
Installation Requirements

Installing Cisco ICM WebView software on a real-time distributor Admin Workstation allows WebView to become a Web server on a corporate intranet. WebView Administrators and WebView Supervisors can log into WebView on this Web server from a browser on their own computer.

Overview

This chapter contains the following topics:

- Cisco ICM WebView Software AW Requirements
- Installing a Supported Web Browser
- Installing Windows 2000 Service Pack 3
- Installing the WebView Third-Party CD Software
- Changing the Jaguar Admin Password
- Setting the Size of the Jaguar Log File
- Deleting Jaguar Log Files
Cisco ICM WebView Software AW Requirements

This section summarizes the hardware and software required for Cisco ICM WebView software.

Note
To install the Cisco ICM WebView software product, you must be an administrator in the same Cisco ICM software domain where the real-time distributor Admin Workstation resides.

System Requirements

Confirm that your Admin Workstation:

- Is a real-time distributor Admin Workstation, rather than a client (non-distributor) Admin Workstation. For more information on how to do this, see the Cisco ICM Software Installation Guide.
- Has 128 MB of RAM and the following amount of free disk space for the Third-Party Software applications:
  - Sun JDK 1.3.1: 35 MB
  - New Atlanta ServletExec ISAPI 4.1.1 patch 15: 5 MB
  - Sybase EAServer 4.1.1 (final disk size): 450 MB

Make sure that you have enough space on each drive for what you intend to install on that drive. While running, the installer software uses approximately 10 MB of RAM and 1 MB of space on the hard drive.

Note
If the drive runs out of space in the middle of the installation, EAServer hangs. In this case, you must end the installation process with the NT task manager and start over on a drive that has more space.

- Has a TEMP environment variable that is defined to be a folder with at least 300 MB of free space. This space is required by the EAServer installation.
Chapter 2  Installation Requirements

Cisco ICM WebView Installation Guide

Chapter 2      Installation Requirements

Cisco ICM WebView Software AW Requirements

Note

If you plan to create new report templates for your users (in addition to the report templates that the WebView program supplies), you must also install Version 5.0 of the Cisco ICM Software Custom Screen Builder program. The Custom Screen Builder program requires Version 8.0 of the InfoMaker program from Sybase.

If you are not sure if your Admin Workstation meets these requirements, contact your Cisco ICM software representative.

Upgrading from a Previous Version of Cisco ICM WebView Software

If you are upgrading your installation from a version of Cisco ICM WebView software prior to ICM 4.6.2, de-install the ChartFX application that was used by that previous version of WebView.

If you plan to create new report templates for your users (in addition to the report templates provided with the WebView program), you must install the 5.0 version of the Cisco ICM Software Custom Screen Builder program. Upgrading your Custom Screen Builder program will also require you to install the 8.0 version of the InfoMaker program from Sybase before you install WebView.

Differences between WebView 4.6.2 and WebView 5.0

Several major differences between WebView 4.6.2 and WebView 5.0 affect existing saved report files. The first major difference concerns the templates supplied and the second difference concerns the storage of saved report files:

- In WebView 5.0, new templates have been added and several existing templates were deleted. The deleted templates were either replaced by templates in the same reporting category, replaced by templates in different reporting categories, or not replaced.

See Appendix A, “Upgrading From a Previous Version of ICM WebView” for more information.
In WebView 4.6.2, saved reports were stored in a directory on the WebView server. In WebView 5.0, a WebView database is used to store saved reports. During WebView installation, most saved report files are migrated to the WebView database, with two exceptions:

- Saved reports created with templates that have been deleted and replaced by templates in different reporting categories were not migrated to the database
- Saved reports created with templates that have been deleted and not replaced were not migrated to the database

Only saved reports stored in the database can be accessed and used in WebView.

**Third-Party Software Requirements**

Make sure that you have all of the software listed in Table 2-1 ready to install before you begin enabling Cisco ICM WebView software.

<table>
<thead>
<tr>
<th>Third-Party Software</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun JDK, Release 1.3.1</td>
<td>Cisco ICM WebView Third-Party Software CD</td>
</tr>
<tr>
<td>New Atlanta ServletExec ISAPI, 4.1.1 patch15</td>
<td></td>
</tr>
<tr>
<td>Sybase EAServer 4.1.1</td>
<td></td>
</tr>
<tr>
<td>EAServer 4.1.1 is an upgrade from Sybase Jaguar 3.6.1, which was used for ICM 4.6.2</td>
<td></td>
</tr>
<tr>
<td>Licenses for New Atlanta ServletExec ISAPI 4.1.1 patch 15</td>
<td>Cisco distributes and automatically installs the 1 and 2-CPU licenses for New Atlanta ServletExec ISAPI 4.1.1 patch 15 when WebView is installed. However, if you are installing WebView on a server that has 4 or more processors, then it is your responsibility to get a 4-CPU or greater than 4-CPU license from New Atlanta.</td>
</tr>
</tbody>
</table>
Chapter 2 Installation Requirements

Cisco ICM WebView Software AW Requirements

Table 2-1 Third-Party Software Requirements (continued)

<table>
<thead>
<tr>
<th>Third-Party Software</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser for displaying WebView reports. Supported browsers: Microsoft® Internet Explorer version 5.5 SP2 and version 6.0.</td>
<td><a href="http://www.microsoft.com/windows/ie">http://www.microsoft.com/windows/ie</a></td>
</tr>
<tr>
<td>Sybase InfoMaker 8.0 (if you plan on creating custom reports. Note that this must be installed before you install ICM. After it is installed, run ICM Setup and select the custom screen builder option in the AW setup. See the <em>Cisco ICM Software Installation Guide</em> for more information.)</td>
<td>Sybase Inc.</td>
</tr>
</tbody>
</table>

While all of the above software is needed on the computer that is the WebView server, only a supported browser is needed on the computers that are the WebView clients.

Third-Party Software Licenses

Installing WebView on a server that has 4 or more processors

Cisco distributes and automatically installs the 1 and 2-CPU licenses for New Atlanta ServletExec ISAPI 4.1 when WebView is installed. If the server that you are installing WebView on has 4 or more processors, then you must get a 4-CPU or greater than 4-CPU license from New Atlanta.

How to install a 4-CPU or more license for New Atlanta


**Step 2** Obtain the license from New Atlanta if you have not already done so.
Installing a Supported Web Browser

Step 3 Open the file `<NewAtlantaRoot>\ServletExec ISAPI\ServletExec Data\servers.properties`, where `<NewAtlantaRoot>` is the New Atlanta directory and its location; for example: C:\Program Files\New Atlanta.

Step 4 Change the line `servletexec.serial=<old_license>`, where `<old_license>` is the old license number, to read `servletexec.serial=<new_license>`, where `<new_license>` is your new license number; for example: 1678290

Step 5 Save the file as a text file in the directory in which you found it.

Step 6 Restart the IIS Admin NT service for the change to take effect.

Supported Languages and Character Set

WebView and ICM5.0 support computer systems with the English language and with languages that use the ISO_1 character set that is used by Western European countries; for example: France, Germany, and Italy.

WebView should be installed on a computer having the same operating system character set as the one on which ICM 5.0 is installed.

If ICM WebView is installed on a computer system using a character set rather than ISO_1, you may see some garbled characters in the WebView Web pages and in the reports containing agent names and descriptions.

Installing a Supported Web Browser

To test your Cisco ICM WebView software installations, you must install one of the following browsers on the Admin Workstation:

- Microsoft Internet Explorer, Version 6.0
- Microsoft Internet Explorer, Version 5.5 SP2

See the Third-Party Software Requirements section preceding this section, for information about the web site where you can download the browser. Follow the download and installation instructions on the web site for the browser you decide to install.
Chapter 2  Installation Requirements

Installing Windows 2000 Service Pack 3

Updating Your Browser’s Cache

For your browser to display real-time report monitoring and script monitoring, you must enable the browser’s settings so that with every visit to a real-time report monitoring or script monitoring page, the version of that page in the browser’s cache will be compared and updated to any newer version on the Cisco ICM WebView software Admin Workstation. The following information was correct when this document was written, but you can refer to the help for your browser to confirm the correct procedure for your browser.

Internet Explorer, version 5.5, SP2 and version 6.0

Use the following procedure to make sure the cache will be updated at each new view of a real-time report.

How to ensure cache updates in Internet Explorer

Step 1  In the Internet Explorer window, choose Internet Options on the Tools menu.
Step 2  If necessary, click the General tab to display the General Settings tab page.
Step 3  On the General Settings tab page, in the Temporary Internet Files section, click Settings.
Step 4  In the Settings dialog box, enable the Every visit to the page option, then click OK.
Step 5  Click OK in the Internet Options dialog box.

Installing Windows 2000 Service Pack 3

For a description of the Windows 2000 Service Pack 3 and for installation instructions, see the ReadMe file that comes with the service pack.
Installing the WebView Third-Party CD Software

Use the WebView Third-Party Software CD for installing:

- Sun JDK1.3.1 software
- New Atlanta ServletExec ISAPI, 4.1.1 patch 15
- Sybase EAServer 4.1.1.

Note

EAServer 4.1.1 replaces the Jaguar 3.6.1 software. EAServer 4.1.1 can only be upgraded from Jaguar CTS 3.6.1 or higher.

If you have lower versions of Jaguar CTS, such as 3.5, already installed on your machine, you must first uninstall it before installing EAServer 4.1.1.

How to install the third-party software

On the Third-Party CD, run the top level Setup.exe program. This first performs several checks on your system for software requirements, and then asks you to select the third-party software options you want to install and where you want that software located. Then it automatically installs the software. The installation procedure can take from 30 to 40 minutes depending on the speed of the machine and the resources available on the machine.

The following is a summary of the installation procedure. See the README.txt file on the third-party CD for any further information.

Step 1

Check to see if you have the Jaguar 3.5 software already installed on your machine.

If Jaguar 3.5 software is installed on your machine, use the control panel’s Add/Remove software program to remove that software.

Step 2

On the Third-Party CD, run the top-level Setup.exe program. Follow the instructions presented on the screen.
Step 3 The Setup program displays a list of the third-party software that is required by WebView. Any software that is not already installed on your system is automatically selected and grayed out in this dialog box. Any software that is already installed on your system, you can reinstall by selecting the check box next to that software option.

By default, the Setup program does not reinstall software that is already installed on your system if its version number has not changed since your last Third-Party CD installation. However, if you select to reinstall this software, then Setup first deletes the former installation before installing the new version.

Review all the automatically selected software options. If you want to re-install any unselected options, select them. Then click Next.

Step 4 When the procedure asks you to choose the destination location for the files, select or enter the directory location and click Next. If you previously installed the software, the default location will be that previous location. Cisco recommends that you choose the default.

The default locations for a new installation are:

- Sun JDK 1.3.1 (35 MB)
  C:\jdk1.3.1\n
- New Atlanta ServletExec ISAPI 4.1.1 patch 15: (5 MB)
  C:\Program Files\New Atlanta\ServletExec ISAPI\n
- Sybase EAServer 4.1.1 (450 MB)
  C:\Program Files\Sybase\EAServer

As Setup installs the software, it displays status messages.

Note At one point, three warnings appear in a console command-line window:
“Server Name not specified. Defaulting to Jaguar.
JDK Version not specified. Defaulting to JDK 1.3.
-jvmtype not specified. Defaulting to client.”

These messages mean that Setup is using the defaults.

The messages are produced by the EAserver installation and are expected.
Step 5  When the programs are installed, the Cisco WebView Third-Party Setup dialog box again displays and prompts you to select when you want to reboot your computer: next or at a later time. Make your selection and click Finish.

After you have rebooted your computer, the third-party software installation is completed.

Step 6  Verify that the Jaguar NT service is installed and started:

a. From the Start menu, select Programs > Administrative Tools > Services.

b. In the Services dialog box, make sure that Jaguar is listed and started:
   – If it is not started, right click on Jaguar and select the Start option from the pop-up selection box.
   – If it is not installed, run the following from the command line window:
     "%JAGUAR%\bin\serverstart.bat" -install
     Then, start the service as indicated in the preceding bullet.


Error Reporting

The installer creates a log file that records the installation progress and errors of the installation for diagnostic purposes. The log file is created in the C:\Temp directory. It is called WVThirdPartyInstaller.log

Any errors that occur during setup are displayed to the user and are recorded in the log file. The log file also contains other important information, such as the build number of the current wrapper installer, the various stages of program execution, minor errors not worth displaying to the user, system settings, and so on. Each entry in the log file contains a time stamp.
Changing the Jaguar Admin Password

After installing Jaguar, you might want to change the default Jaguar Admin password for security reasons. However, this is not required.

How to change the Jaguar Admin password

1. In the Start menu, select Programs > Sybase > EAServer 4.1.1 > Jaguar Manager. This opens the Sybase Central Java Edition dialog box.

2. In Tools menu of the Sybase Central Java Edition dialog box, select Connect > Jaguar Manager. This opens the Login dialog box.

3. In the Login dialog box, click Connect. If you get a message saying the user name field is empty:
   a. Enter jagadmin in the User Name text box.
   b. Enter <your machine name> in the Host Name text box.

   **Note** The previous version of Jaguar required you to enter “localhost.” However, EAServer 4.1.1 requires you to enter your machine name.

   You can get your machine name by right clicking on the My Computer icon in your desktop and then selecting Properties from the pop-up menu. In the System Properties dialog box, the Network Identification tab displays your machine name.

   c. You can leave the default (9000) in the Port Number text box.
   d. Click Connect.

4. From the directory tree in the Sybase Central Java Edition dialog box, select Jaguar Manager > Servers > Jaguar.

5. In the menu bar, select File > Server Properties.


7. In the Administration box, click Setjagadmin Password.
Changing the Jaguar Admin Password

Step 8  In the **Administrator Password** dialog box, enter the password in the **New jagadmin Password** text box and then re-enter it in the **Verify New jagadmin Password** text box.

Step 9  Click **OK**. In the “The password has been changed.” message box, click **OK** again. Click **OK** a third time to close the Administration box. And then select **File > Exit** from the menu bar to close the Sybase Central Java Edition dialog box.

**Note**  This step changes the password. However, the next set of steps are also necessary so that WebView knows what the new password is.

Step 10  In a text editor, open the file

```
%Jaguar%\html\classes\com\cisco\atg\jagconnection.properties
```

where

```
%Jaguar%
```

is the system variable pointing to the directory location of the Jaguar (EAServer) files.

Step 11  In the file, after `JAGCONNECT_JAGUAR_ADMIN_PWD=`, enter your new password.

**Example jagconnection.properties File**

```
JAGCONNECT_CORBA_ORB_CLASS=com.sybase.CORBA.ORB
JAGCONNECT_JAGUAR_SERVER=localhost
JAGCONNECT_IIOP_PORT=9000
JAGCONNECT_JAGUAR_ADMIN=jagadmin
JAGCONNECT_JAGUAR_ADMIN_PWD=*
JAGCONNECT_JAGUAR_SYS_BEAN=webview/n_icmsysinfo
JAGCONNECT_JAGUAR_DW_BEAN=webview/n_icmdw
```

Step 12  Save the **jagconnection.properties** file.
Setting the Size of the Jaguar Log File

Jaguar software writes to a log file as it processes information. The default log file size is 5 Megabytes. If you need to change its size, use the following procedure.

How to set the size of the Jaguar log file

Step 1 In the Start menu, select Programs > Sybase > EAServer 4.1.1 > Jaguar Manager. This opens the Sybase Central Java Edition dialog box.

Step 2 In the Tools menu of the Sybase Central Java Edition dialog box, select Connect > Jaguar Manager. This opens the Login dialog box.

Step 3 In the Login dialog box:
   a. Enter jagadmin in the User Name text box.
   b. Enter <your_machine_name> in the Host Name text box.
   c. You can leave the default (9000) in the Port Number text box.
   d. Click Connect.

Step 4 In the directory tree box of the Sybase Central Java Edition dialog box, click Jaguar Manager and then the Servers branch.

Step 5 In the Servers column on the right side of the dialog box, right click on Jaguar and in the pop-up menu, select Server Properties.

Step 6 In the Server Properties dialog box, select the Log /Trace tab.

Step 7 In the Log /Trace tab:
   a. Enter the log file size in bytes in the Log File Size in bytes text box; for example: 1000000. The default is 5000000. When the log file reaches the set size, a new log file is created with the current date and time and the.log suffix.
   b. Remove the check mark from the Truncate Log on Startup check box.

Note that:

- If this box is checked, then the jaguar log will be deleted every time that the Jaguar service is started (every time you restart WebView).
- If this box is not checked, then the Jaguar log will grow to the Log File Size in bytes specified in Step 7a before being renamed and a new log file is created.
Deleting Jaguar Log Files

Once you set the log file's size, Jaguar creates a new log file each time the data grows beyond the selected size. Consequently you can have many log files. You should delete old log files occasionally to keep them from unnecessarily consuming too much space on your system.

How to delete Jaguar Log Files

Step 1  Go to the Jaguar root directory where they are stored. The default location for this directory is 

%JAGUAR%\bin

where %JAGUAR% is an environment variable defined in windows.

Step 2  Select the outdated log files and delete them.

Uninstalling the Third Party Software

You can uninstall the third party software by using the Add/Remove Programs software in the Windows NT Control Panel.

Note  If you remove the third party software files and then reinstall them, you should then run ICM Setup in Upgrade All mode to prevent any problems when using WebView. See Appendix B, “Troubleshooting Tips” for further information.
Installing Cisco ICM WebView Software and Setting Up Users

After following the instructions in Chapter 2, you are ready to install (or update) the Cisco ICM WebView option on the Admin Workstation.

Overview

This chapter contains the following topics:

- Installing Cisco ICM WebView Software
- Testing (Logging into) Your WebView Installation
- Troubleshooting Your WebView Installation
- Enabling, Adding, and Maintaining ICM Agents
- Assigning an Agent to be a Supervisor
- Setting Up WebView Users

For how to install and maintain the ICM system including the ICM databases, see the Cisco ICM Software Installation Guide and the Cisco ICM Software Administrator Guide or the Cisco ICM Software IPCC Administrator Guide.

For how to setup agents within the ICM system or within an ICM application, see the Cisco ICM Software Configuration Guide or the appropriate ICM application guide.
Installing Cisco ICM WebView Software

After the required software is installed, you are ready to install (or upgrade) the WebView option on the Admin Workstation. If you are installing the Admin Workstation software for the first time, see the Cisco ICM Software Installation Guide for information about installing the Admin Workstation.

Use the following procedure to install Cisco ICM WebView software.

How to install WebView software

**Step 1** Run **Setup** from the ICM CD. See the Cisco ICM Software Installation Guide for information on how to use the Setup program.

If you are installing the Admin Workstation software for the first time, you will be enabling the **WebView** option on the Admin Workstation Properties window. If you are upgrading from an earlier version of the Admin Workstation software, you will be completing the upgrade.

**Step 2** In the Cisco ICM Setup dialog box, select **AW** in the Instance Components section on the right-hand side of the dialog box.

**Step 3** In the same dialog box, in the ICM Instances section, on the left-hand side of the dialog box, select the **ICM instance** where the Admin Workstation running WebView will be installed.

**Step 4** Click the **Edit** button associated with the Instance Components section on the right-hand side of the dialog box. The Admin Workstation Properties dialog box displays.

**Step 5** Click **Next**. The Real-Time Distributor Node Properties dialog box displays.

**Step 6** In the Real-Time Distributor Node Properties dialog box, enable the **WebView Reporting** option check box.

**Step 7** In the WebView database host name text box, enter the **WebView database host name**. This is the name of the computer that you want to hold the database server which WebView uses to store saved reports and favorites reports.

**Step 8** Click **Next** and proceed with the setup. When the installation is complete, and you are prompted in the Cisco ICM Setup dialog box, you can exit from Setup.
Chapter 3 Installing Cisco ICM WebView Software and Setting Up Users

Installing Cisco ICM WebView Software

Step 9 If you are prompted to do so, restart your system in order to ensure that all of the appropriate software is running.

Installing WebView for ICM Instances and for Customers

An instance is a single logical ICM system. An instance typically consists of several software components (CallRouter, Logger, Peripheral Gateways, Admin Workstations)—some of which may be duplexed—typically installed on several different computers. For example, a single computer can run multiple components of a single instance or components of multiple instances.

A customer is an organization that uses ICM software to manage its contact center enterprise. Each customer has its own dialed numbers, labels, call types, scripts, and scheduled targets. However, all Peripheral Gateways, peripherals, services, skill groups, and so on are associated with the instance rather than a specific customer. Therefore, customers who share an instance cannot have their own Peripheral Gateways. Such customers, however, can be assigned a network IVR with customer-specific scripts for special call treatment.

In Release 5.0, a single ICM instance can be shared by several customers with limited functionality. However, you can set up WebView users who have access to the data for only a specific customer.

Table 3-1 summarizes what data can be associated with a specific customer and what data is shared by an entire instance.

<table>
<thead>
<tr>
<th>Customer Data</th>
<th>Instance Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialed numbers, labels, call types, scripts, scheduled targets, and network VRU scripts</td>
<td>Network ICM systems and Peripheral Gateways; peripherals, trunk groups, peripheral targets, skill targets; regions; announcements; application gateways</td>
</tr>
</tbody>
</table>

See the Cisco Network Applications Manager (NAM) Setup and Configuration guide for how to configure and use the Cisco Network Applications Manager (NAM), instances, and customers.
You can use the customer concept to support multiple independent organizations with a single ICM instance rather than assigning a separate instance to each organization. However, customers that share an instance have more limited capabilities than a customer using a full instance. Table 3-2 summarizes the abilities of these two customer types for WebView users.

<table>
<thead>
<tr>
<th>Table 3-2  Customer Types</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Full Instance Customer</strong></td>
</tr>
<tr>
<td>Admin Workstation and WebView</td>
</tr>
</tbody>
</table>

Note that all configurations for a shared instance customer must be performed by the service provider that manages the instance.

Creating a WebView Administrator

Cisco ICM WebView software administrators can use a Web browser to:

- Connect to the WebView server.
- Monitor, define, and modify Cisco ICM WebView reports.

For ICM software to recognize and authorize a WebView administrative user, you must add that user with the Configuration Manager User List tool.

**Note**

Only ICM users are allowed to login to the WebView. The NT Domain Administrator by default is not able to login to WebView. To log into WebView, the administrator has to be made an ICM user.

Use the following procedure to add a new WebView administrator through the Configuration Manager.

**How to create a new WebView administrator**

1. In the ICM Admin Workstation folder, open the **Configuration Manager** utility.
2. From the menu bar, select the **User List** tool.
Chapter 3 Installing Cisco ICM WebView Software and Setting Up Users

Installing Cisco ICM WebView Software

Step 3 If you have not selected the option to have the data automatically displayed when you open the tool, click Retrieve to enable the Add button.

Step 4 Click Add User.

An ICM user is one who has access to ICM configuration data.

Each user who can access the ICM configuration data must have a valid NT user name and password.

Note ICM user names must begin with a letter and can contain only letters and numbers. If the NT user name contains characters other than the preceding, remove those characters from the ICM user name. For example, hyphens (-) are not allowed in user names.

Step 5 In the user Attributes tab, enter the user’s Domain name, user name, and password.

Note The user’s domain name along with the user name become the WebView login name. The password becomes the WebView password.

Once these are entered and saved, the new ICM user can use that domain name, user name, and password to open WebView.

The user’s password expiration date is set by the user’s domain, not by WebView.

If you want the user to be able to create other WebView users, also select Can create other user accounts. See the Configuration Manager’s User List tool online help for descriptions of each attribute (data property).

Step 6 Click Save.

Note Creating a WebView user by using the User List tool enables that user to see all WebView data, not just data for an agent team as is the case of a supervisor of an agent team.
Testing (Logging into) Your WebView Installation

Use the following procedure to test that you have correctly installed WebView.

How to log in to WebView

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Open your browser window.</td>
</tr>
</tbody>
</table>
| Step 2 | In the Address bar in Internet Explorer, enter the WebView URL. Use the following format: `http://Admin Workstation/instance`  
Where:  
- The name of the Admin Workstation is the name of the WebView server (the computer) containing the ICM Admin Workstation on which WebView is enabled.  
- The instance is the ICM instance name on that WebView server.  
For example: `http://Boston1/cust1` |
| Step 3 | Press the **Enter** key on your keyboard. The software prompts you for a username and password. |
| Step 4 | Enter your WebView username and password. Use the following format: `domainname/username`  
Where:  
- `Domainname` is the name of the domain where the user has his/her NT account.  
- `Username` is the name assigned to the user by the WebView administrator.  
For example: `sherwood/rhood` |

**Note**  
The username is case sensitive.

If you have installed WebView correctly, the browser displays the opening WebView page.
Figure 3-1  Summary Example of Log In User Input

WebView URL in browser address/location bar:  http://Boston1/floor2
Username in WebView username text box: Cambridge4/jsmith
Password in WebView password text box: yoursecretpassword

Troubleshooting Your WebView Installation

If your browser does not display the opening WebView page, check the following:

- Are you using one of the supported browsers?
- Did you use the correct the URL? http://Admin Workstation/instance
- Did you enter the correct domain name and username for the username and enter the correct password?
- Confirm that your Cisco ICM software WebView installation meets all of the requirements listed Chapter 2.

For more trouble shooting tips, see Appendix B, “Troubleshooting Tips.”

If your browser still does not display the WebView home page, contact Cisco Connection Online (CCO) as described in “About This Guide” at the beginning of this guide.

Enabling, Adding, and Maintaining ICM Agents

Agents (except for supervisors) are not WebView users, but they can be included in WebView reports.

Note Since agents are not ICM users, they cannot run any WebView reports. Supervisors, however, are special agents who are ICM users with limited privileges. Supervisors can see only their agent team reports. No agent in their teams or other teams can see any WebView data, as they are not ICM users.

You can create and maintain agents in the ICM Configuration Manager, the ICM Collaboration application, or the ICM E-Mail Manager application. Creating them in one of the preceding makes them available to all.
Enabling, Adding, and Maintaining ICM Agents

If agents are created by using the ICM Configuration Manager and you want them to be able to work on an ICM application, you must also enable them in that application.

For how to create and enable agents in an ICM application, see that application’s documentation.

Enabling Agent Data

You cannot create a report on an agent until you have enabled the agent data in ICM on the peripheral where the agent is assigned.

How to enable agent data on an ICM peripheral

1. In the ICM Admin Workstation folder on the computer where WebView is installed, open the Configuration Manager utility. Use the online help or the ICM Configuration Guide during the procedure if you have any questions.

2. In the Configuration Manager, open the PG Explorer.

3. In the PG Explorer, select the peripheral to which an agent(s) is assigned.

4. Select the Peripheral tab. If the peripheral’s client type is CallManager/Soft ACD, you must select, in the Peripheral tab, a Default desk settings. Otherwise, skip this step.

   Agent desk settings are settings for an IPCC agent’s phone or PC screen that are defined in the ICM database. Other types of agents have these settings defined in the ACD.

   If NONE is the only option in the selection list, you need to create desk settings. To create desk settings, use the Configuration Manager’s Agent Desk Settings List tool.

5. In the Agent Distribution tab, select Enable agent reporting.

6. Enter any needed agent distribution entries.

   Agent distribution is the flow of agent data from a specific peripheral to a specific real-time distributor.
A real-time distributor is an Admin Workstation that receives real-time monitoring data directly from the ICM Central Controller. The distributor then passes this data on to other Admin Workstations at the same site. For each ICM site, typically two Admin Workstations are set up as distributors, but only one is active at any time.

You can stop the flow of all agent real-time data to a distributor when you are not viewing agent real-time reports.

### Adding and Maintaining ICM Agents

#### Setting Up Agents

See the *ICM Configuration Manager’s* online help and or the *Cisco ICM Software Configuration Guide* for how to:

- Add and maintain agents, teams, skill groups, and services within ICM.
- Assign agents to teams and/or to skill groups.
- Assign a feature control set to an agent.

*Feature Control Set* is the set of tools (and features in some of the tools, such as the Script Editor) in the ICM Configuration Manager and in the Admin Workstation group to which an assigned user has access.

By defining different feature control sets and assigning them to the appropriate users, only those ICM tools and features that a user needs is automatically available to that user.

- Assign skill groups to services.
- Enable agent state trace.

This option must be enabled for historical reports to list historical agent states. This option is not needed to see the current agent state in a real-time report.
Assigning an Agent to be a Supervisor

**Note** Enabling the Agent State Trace option causes the generation of a large amount of historical data. It is recommended that you only enable this option for a small subset of your agents and only for a limited amount of time.

### WebView User’s Password Expiration and Domain Security Settings

WebView (ICM) users take their security setting from the domain on which they are created. WebView users also cannot create or change their password from within WebView. However, the WebView administrator can create and change WebView users passwords.

Therefore, the WebView administrator must be aware of the domain security policy setting on password expiration so that WebView users are not accidentally locked out of their accounts.

### Assigning an Agent to be a Supervisor

WebView supervisors can use a Web browser to:

- Connect to the WebView server.
- Monitor WebView reports for their team(s).

**Note** A supervisor agent (a WebView user created through the following procedure) can see report data only on the agents in that supervisor’s team while an ICM administrator (one created through the Configuration Manager’s User List tool) can see report data on all agents.
Use the following procedure to assign an agent to be a supervisor. If you have any questions, use the ICM Configuration Manager’s online help.

**How to assign an agent to be a supervisor**

**Step 1**  
In the ICM Admin Workstation folder, open the **Configuration Manager** utility and select the **Person List** tool.

**Step 2**  
In the Person List tool, enter the **personal information** for the agent. This is primarily a person’s first and last name and login password.

Every agent is associated with a person record. This record must exist before you can create an agent in ICM software.

The purpose of the person record is so that, in a multi-channel contact center, one person can be assigned as an agent on different peripherals. For example, the person might handle both e-mail and phones. You can associate a person with only one agent at a peripheral. However, you can associate the same person to more than one agent if those agents (to which the person is associated) are at different peripherals.

**Step 3**  
Open the Configuration Manager’s **Agent Explorer** tool and create an **agent** by associating the person record you created with an agent name.

**Step 4**  
In the Agent Explorer Supervisor tab, select **Supervisor Agent**.

**Step 5**  
Enter the agent’s **domain name**, create a **supervisor login name** and **password**, and click **Save**.

The supervisor uses that login name and password to log into WebView.

**Note**

- The supervisor does not use a login name and password created by the ICM User List tool.
- If the supervisor also has an ICM account created by the User List tool, then the supervisor login name (created in the Supervisor tab of the Agent Explorer) must be different from the user login name created in the User List tool.
- The agent’s domain sets the expiration date on the password.
Setting Up WebView Users

Use the Configuration Manager utility to set up user accounts for any users who need to access WebView on your Admin Workstation. See Creating a WebView Administrator earlier in this chapter, for an overview on adding a new user.

Each user needs to:

- Be added as a user with the ICM Configuration Manager utility.
- Have network access to the Cisco ICM software WebView Admin Workstation.
- Install a supported Web browser.
- Enable the browser’s settings so that with every visit to a real-time report monitoring page, the version of that page in the browser’s cache will be compared and updated to any newer version on the Cisco ICM software WebView Admin Workstation.
- Know how to enter the correct WebView URL:
  
  http://AdminWorkstation/instance

- Know how to enter the correct domain name and username for the username and how to enter the correct password.
- Know that help is available for using WebView from the WebView window.
Upgrading From a Previous Version of ICM WebView

Several major differences between WebView 4.6.2 and WebView 5.0 affect existing saved report files. The first major difference concerns the templates supplied and the second difference concerns the storage of saved report files.

In WebView 5.0, new templates have been added and several existing templates were deleted. The deleted templates were either replaced by templates in the same reporting category, replaced by templates in different reporting categories, or not replaced.

In WebView 4.6.2, saved reports were stored in a directory on the WebView server. In WebView 5.0, a WebView database is used to store saved reports. During WebView installation, most saved report files were migrated to the WebView database, with two exceptions:

- Saved reports created with templates that have been deleted and replaced by templates in different reporting categories were not migrated to the database
- Saved reports created with templates that have been deleted and not replaced were not migrated to the database

Only saved reports stored in the database can be accessed and used in WebView. This section discusses:

- Differences between ICM WebView 4.6.2 and ICM WebView 5.0
- Templates that have been deleted and replaced by templates in the same reporting category
• Templates that were deleted and replaced by templates in different reporting categories
• How to view saved report files that were not migrated to the WebView database
• Templates that were deleted and not replaced

Differences between ICM WebView 4.6.2 and ICM WebView 5.0

Several major differences between WebView 4.6.2 and WebView 5.0 affect existing saved report files. The first major difference concerns the templates supplied and the second difference concerns the storage of saved report files.

In WebView 5.0, new templates have been added and several existing templates were deleted. The deleted templates were either replaced by templates in the same reporting category, replaced by templates in different reporting categories, or not replaced.

In WebView 4.6.2, saved reports were stored in a directory on the WebView server. In WebView 5.0, a WebView database is used to store saved reports. During WebView installation, most saved report files were migrated to the WebView database, with two exceptions:

• Saved reports created with templates that have been deleted and replaced by templates in different reporting categories were not migrated to the database
• Saved reports created with templates that have been deleted and not replaced were not migrated to the database

Only saved reports stored in the database can be accessed and used in WebView.

Templates that have been deleted and replaced by templates in the same reporting category

Most deleted templates were replaced by templates in the same reporting category. For example, agteam01 was replaced by agteam20. During WebView installation, saved reports made using these deleted template were moved automatically to the WebView database and updated to use the replacement template.
You can access existing saved reports created with these deleted templates as usual in WebView. When you run the report, the report uses the replacement template.

The following table contains the list of WebView 4.6.2 templates deleted and replaced by other templates in the same reporting category.

**Table A-1 Replacement Templates in the Same Reporting Category**

<table>
<thead>
<tr>
<th>Deleted Template</th>
<th>Replacement Template</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>agteam01_agent_status_by_position</td>
<td>agteam20: Agent Team Real Time</td>
<td>The Last State Change field has been replaced with a Duration in Current State field.</td>
</tr>
<tr>
<td>agtper01_agent_status_by_position</td>
<td>agtper20: Agent Peripheral Real Time</td>
<td>The Last State Change field has been replaced with a Duration in Current State field.</td>
</tr>
<tr>
<td>agtskg01_agent_status_by_position</td>
<td>agtskg20: Agent Skill Group Real Time</td>
<td>The Last State Change field has been replaced with a Duration in Current State field.</td>
</tr>
<tr>
<td>agtskg02_agent_status_by_skill_group</td>
<td>agtskg20: Agent Skill Group Real Time</td>
<td></td>
</tr>
<tr>
<td>caltyp07_calls_statistics_real_time</td>
<td>caltyp20: Call Type Real Time</td>
<td></td>
</tr>
<tr>
<td>caltyp03_effect_of_aban_on_servicelevel</td>
<td>caltyp20: Call Type Real Time</td>
<td></td>
</tr>
<tr>
<td>caltyp06_calls_statistics_half_hour</td>
<td>caltyp21: Call Type Half Hour</td>
<td>The Call Errors field does not appear in the replacement template.</td>
</tr>
<tr>
<td>entskg02_status_grid</td>
<td>entskg20: Enterprise Skill Group Status Real Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>the %Idle, %Avail, %Talking, %Wrap Up, and %BusyOther fields do not appear in the replacement template.</td>
</tr>
<tr>
<td>Deleted Template</td>
<td>Replacement Template</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>entskg06_halfhour_aht_grid</td>
<td>entskg23: Enterprise Skill Group Performance Summary Half Hour</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The FTE # of Agents field does not appear in the replacement template. You can use the entskg08: FTE for Enterprise Skill Groups Half Hour template to view FTE data.</td>
<td></td>
</tr>
<tr>
<td>entskg07_daily_aht_grid</td>
<td>entskg24: Enterprise Skill Group Agent Performance Daily</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The FTE # of Agents field does not appear in the replacement template. You can use the entskg08: FTE for Enterprise Skill Groups Half Hour template to view FTE data.</td>
<td></td>
</tr>
<tr>
<td>entskg13_skill_group_call_analysis</td>
<td>entskg21: Enterprise Skill Group Task Summary Half Hour</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The Monitored Calls and Whispered Calls fields do not appear in the replacement template because they are not supported for IPCC configurations.</td>
<td></td>
</tr>
<tr>
<td>peragt01_agent_status_by_position</td>
<td>agent20: Agent Real Time</td>
<td></td>
</tr>
<tr>
<td>perskg02_status_grid</td>
<td>perskg20: Peripheral Skill Group Status Real Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: the %Idle, %Avail, %Talking, %Wrap Up, and %BusyOther fields do not appear in the replacement template.</td>
<td></td>
</tr>
<tr>
<td>perskg06_halfhour_aht_grid</td>
<td>perskg23: Peripheral Skill Group Performance Summary Half Hour</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The FTE # of Agents field does not appear in the replacement template. You can use the perskg08: FTE for Enterprise Skill Groups Half Hour template to view FTE data.</td>
<td></td>
</tr>
</tbody>
</table>
Several templates were deleted and replaced by templates in a different reporting category. Existing saved reports made using the deleted templates were not migrated to the WebView database during installation and therefore cannot be viewed in WebView.

The following table lists deleted templates and their replacements in different reporting categories.

**Table A-2 Replacement Templates in a Different Reporting Category**

<table>
<thead>
<tr>
<th>Deleted Template</th>
<th>Replacement Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>agtper02_agent_status_by_skill_group</td>
<td>agtskg20: Agent Skill Group Real Time</td>
</tr>
<tr>
<td>entsvc10_queue_point_service_level</td>
<td>caltyp20: Call Type Real Time</td>
</tr>
<tr>
<td>entsvc19_queue_point_service_level</td>
<td>caltyp21: Call Type Half Hour</td>
</tr>
</tbody>
</table>
If you want to recreate a deleted report in WebView, use the replacement template to create the report and follow the wizard to add items to the report and, if necessary, date and time range. If you do not remember the parameters of the deleted report, follow the directions below to open the text version of the report file stored on the WebView server and view the parameters.

### How to view saved report files that were not migrated to the WebView database

Although you cannot use WebView to view saved reports that were not migrated to the WebView database, you can open the saved report files in a text editor to view the parameters used when you created the report. Parameter examples include date and time range, agents, and peripherals. You can use these parameters when running a new report in WebView.

**To view saved report files that were not migrated to the WebView database**

---

<table>
<thead>
<tr>
<th>Deleted Template</th>
<th>Replacement Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>ipcc_entsvc20_hh_grid</td>
<td>caltyp21: Call Type Half Hour</td>
</tr>
<tr>
<td>ipcc_entsvc21_day_grid</td>
<td>caltyp22: Call Type Daily</td>
</tr>
<tr>
<td>peragt02_agent_status_by_skill_group</td>
<td>agtsgk20: Agent Skill Group Real Time</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Navigate to the directory in which saved report files are stored. After you install WebView 5.0, back-up files of existing saved reports are located in the following directories:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- &lt;drive&gt;:\icm&lt;instance&gt;\dis\web\userdata&quot;private&quot; or &quot;shared&quot;&lt;username&gt;\wv_converted</td>
</tr>
<tr>
<td></td>
<td>- &lt;drive&gt;:\icm&lt;instance&gt;\dis\web\userdata\shared\all\wv_converted</td>
</tr>
</tbody>
</table>

| Step 2 | Open the saved report file in a text editor. |
Appendix A      Upgrading From a Previous Version of ICM WebView

Templates that were deleted and not replaced

The following templates have been deleted and not replaced:

perskg10_normalized_agt_state
persvc09_forecast_aht_offer_grid
schimp01_name_time_numbers

Saved reports made using these templates were not moved to the WebView database during installation, and cannot be accessed through WebView.
Troubleshooting Tips

Tip Organization
This appendix is organized first by the software in which you might find a problem. Then it is organized by found problems with their solutions.

Overview
If you are having problems with your WebView installation, first check Troubleshooting Your WebView Installation in Chapter 3. That section covers what you should know when you log into WebView. This appendix lists additional troubleshooting tips.

If you still have problems, contact the Cisco Connection Online (CCO) as described in “About This Guide” at the beginning of this guide.

This appendix contains the following sections:

- Troubleshooting by following the call flow
- Graphical Reports and the Job Scheduler: Incorrect display and improper function
- Third-Party Software Installation Error Message: IIS Admin Service not correctly configured
- Java code displayed on opening Webview
- Error message on attempting to select a WebView template
- Error message after changing the Jaguar Admin Password
- Saving time when creating large or many historical reports
- WebView-Only User Unable to Change Password
Troubleshooting by following the call flow

Figure B-1  A diagram of the Call Flow and WebView Interaction with It

The information Call Flow in Figure B-1 Described

Step 1  Client makes a request to access WebView.
Step 2  IS displays WebView to the user.

Note  In ICM authentication is handled by IIS/NT authentication, no UI Server requests are necessary.

Step 3  After several requests and responses (steps 1 and 2 repeated a few times) client requests a report.

Step 4  NewAtlanta is called to compile the JSP page.

Step 5  Jaguar component is invoked to query the database.

Step 6  Query is sent based on the template chosen.

Step 7  Data is returned to Jaguar.

Step 8  Jaguar renders the data as HTML based on the chosen template.

Step 9  NewAtlanta uses the HTML to finish compiling the page.

Step 10  Page is served back to user.

Example B-1  Troubleshooting: What can be observed from the call flow

<table>
<thead>
<tr>
<th>If the problem is…</th>
<th>Try looking at…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can’t log in under CEM/Integrated</td>
<td>The ServletExec log</td>
</tr>
<tr>
<td>Can’t log in under ICM</td>
<td>ICM Config Manager</td>
</tr>
<tr>
<td>No items are displayed</td>
<td>The Jaguar log</td>
</tr>
<tr>
<td>No pages are displayed</td>
<td>Check that “Show friendly HTTP error messages” is disabled in Internet Explorer to ensure you are seeing an accurate error message. Check that the “Default Web Site” is running under Control Panel-&gt;Administrative Tools-&gt;Internet Services Manager</td>
</tr>
<tr>
<td>No templates are found</td>
<td>Make sure the Jaguar service is running, and that the templates exist on the hard drive of the WebView server.</td>
</tr>
<tr>
<td>Report comes back blank or with an error message</td>
<td>The Jaguar log</td>
</tr>
</tbody>
</table>
Graphical Reports and the Job Scheduler: Incorrect display and improper function

**Problem:**
Incorrect display of graphical reports and/or the Job Scheduler does not function properly.

**Explanation:**
To view graphical reports and use the Job Scheduler in a Microsoft Internet Explorer browser, all ActiveX Controls and plug-ins must be enabled in the browser's Security Settings.

**Solution:**
If graphical reports are displaying incorrectly or the Job Scheduler is not functioning correctly, you should check the Security settings and modify them if necessary. The following directions apply to Microsoft Internet Explorer 5.5 SP2.

**To ensure that the Microsoft Internet Explorer Security settings are set correctly**

**Step 1**
Click **Tools> Internet Options** in the browser's menu. The Internet Options window opens.

**Step 2**
Click the **Security** tab.

**Step 3**
Click **Local Intranet**.

**Step 4**
Click **Custom Level** in the Security level for this zone section. The Security Settings window opens.

**Step 5**
In the Activex Controls and Plug-ins section, ensure that the **Enable** radio button is selected for the following options:
- Download signed ActiveX Controls.
- Initialize and script ActiveX Controls not marked as safe.
- Run ActiveX Controls and Plug-ins.
- Script ActiveX Controls marked safe for scripting.
Step 6  Click OK to apply the settings and close the Security Settings window. If a dialog box opens, asking Are you sure you want to change the security settings for this zone, click Yes.

Step 7  Click OK to close the Internet Options dialog box. The Job Scheduler and graphical reports now function correctly.

Third-Party Software Installation Error Message: IIS Admin Service not correctly configured

Problem:

During the installation of the 3rd Party Software for WebView, an error message says that the IIS Admin Service was configured incorrectly.

Explanation

Some operations can cause the IWAM account, which is the identity under which out of process IIS applications run, to become out of sync with the COM+ data store and IIS or the SAM.

When IIS Admin Service starts up, the account information stored in the IIS Metabase is synchronized with the local SAM, but the COM+ applications are not automatically updated. The result of this is that requests to out of process applications fail.

Running the synciwam.vbs admin script updates the IIS COM+ applications with the correct identity and solves this problem.

Solution:

Step 1  Go to the <IIS Install Drive>/Inetpub/AdminScripts/synciwam.vbs directory.

Step 2  Right click synciwam.vbs.

Step 3  Select Open with Command Prompt. A command window opens. Wait until it closes. This runs the synciwam.vbs script and fixes the problem.
World Wide Publishing Service: Stopping it and restarting WebView

Problem:
Stopping the world wide web publishing service stops WebView but WebView is not back when the service is restarted

Explanation:
Stopping the Web Publishing service, but not the IIS Admin service, crashes New Atlanta with errors. The errors can be seen in the DBMON process (launched from the ServletISAPI root before stopping the service). When you restart the web publishing service, the New Atlanta does not start.

The effect of this problem is that if WebView is running and Web publishing is stopped, WebView goes down. Restarting the service does not bring WebView back up.

Workaround:
This error is due to a limitation in IIS. The workaround is to restart the IIS Admin Service.

To restart the IIS Admin Service

Step 1 From the Start button, select Settings > Control Panel > Administrative Tools > Services
Step 2 In the Services dialog box list of services, double click IIS Admin Service.
Step 3 In the IIS Admin Service Properties dialog box, click Start.
Step 4 Click OK and then exit the Services dialog box.
Java code displayed on opening Webview

Problem:

When you attempt to open WebView, java code is displayed rather than the WebView window.

Explanation:

This can happen if some WebView files are missing from the New Atlanta directory.

If you uninstall the New Atlanta Servlet, some WebView files are removed along with the New Atlanta Servlet files because they are installed in the New Atlanta Servlet directory. If you then reinstall the New Atlanta Servlet files, and try to run WebView, you will have the preceding problem.

Solution

Rerun ICM Setup in Upgrade All mode to make sure the missing WebView files get reinstalled correctly.

Error message on attempting to select a WebView template

Problem:

When you open WebView and attempt to select a template, instead of displaying the list of templates, WebView displays the following error message:

“org.omg.CORBA.OBJECT_NOT_EXIST: minor code: 0 completed: No”

Explanation:

This can happen if some WebView files are missing from the Jaguar directory.

If you uninstall Jaguar, some WebView files are removed along with the Jaguar files because they are installed in the Jaguar directory. If you then reinstall Jaguar and try to run WebView, you will have the preceding problem.

Solution

Rerun ICM Setup in Upgrade All mode to make sure the missing WebView files get reinstalled correctly.
Error message after changing the Jaguar Admin Password

Problem
If you change the Jaguar admin password without also changing the Jaguar server properties file, you will get an error message when attempting to open the WebView templates window.

Explanation
When changing the Jaguar admin password, WebView requires that you change it in both the Jaguar Manager Login dialog box and in the Jaguar Server Properties file.

Solution
See the procedure for changing the Jaguar Admin Password in Changing the Jaguar Admin Password, page 2-11.

Saving time when creating large or many historical reports

Problem
Large historical reports can take extra time to create depending on the amount of data. Large numbers of historical reports can also slow down the simultaneous creation of real-time reports.

Solution 1
With the job scheduler, schedule historical reports, especially large ones, to be created during the evening hours or when the system is in less use.

Solution 2
For situations where the size or number of historical reports being created is slowing down the creation of real-time reports, set aside one WebView server for real-time reporting only and another for historical reporting only.

The simplest way to separate the servers is to ask the users to use one URL for real-time reports and other for historical reports. So that users can see only those templates that should be run on a server, you can also delete the real-time templates on one WebView server (using the Custom Screen Builder), and delete the historical templates on the other server.
WebView-Only User Unable to Change Password

Problem

When a WebView user’s password expires, that user cannot update the password from within WebView.

Explanation

ICM users must be aware of the domain security policy setting on password expiration. If it is anything other than never, an ICM WebView user who doesn't log into an ICM workstation, could have their password expire without their being able to change it.

An ICM user (a WebView user) password cannot be changed from within WebView, and it can only be changed or reset on an ICM workstation.

Solution

If a WebView user’s password expires, the user must either login into an ICM workstation or see the domain administrator to reset the password. If you do not know the domain security policy setting, see your domain administrator.
WebView-Only User Unable to Change Password
INDEX

A

administrator
  creating 3-4
agents
  enabling, adding, maintaining 3-7
  enabling agent data 3-8

C

client system sizing 1-2
Configuration Manager application 3-4
creating
  new report templates 2-3
customer data 3-3
Custom Screen Builder program 2-3

D

de-installing previous WebView version 2-3
domain name 3-6

E

Error reporting
  third-party CD software 2-10

H

hardware guidelines 1-2

I

ICM customers and instances 3-3
InfoMaker program 2-3
installing
  browser 2-6
  requirements 2-1
testing 3-6
  upgrade 2-3
  WebView 3-2
  WebView third-party CD software 2-8
instance data 3-3
J

Jaguar Admin Password 2-11
Jaguar log file 2-13
deleting 2-14
finding 2-13
setting its size 2-13

L

Licenses 2-5
logging in
example 3-7
how to 3-6

P

password 3-6
password expiration policy 3-10

R

report templates
deleted and replaced A-1
report templates, creating 2-3
report templates, creating new 2-3

requirements
installation 2-1
third-party licenses 2-5
upgrade 2-3

S

server system sizing 1-2
size guidelines
clients 1-2
servers 1-2
supervisors
creating 3-10

T

templates
deleted and replaced A-1
testing installation 3-6
third-party software
installation log file 2-13
troubleshooting
additional tips B-1
initial steps 3-7

U

upgrade requirements 2-3
username
  format for entering  3-6
users
  setting up  3-12

W

WebView
  creating an administrator  3-4
  creating a user  3-4
  creating supervisors  3-10
  enabling, adding, maintaining agents  3-7
  enabling agent data  3-8
  installing  3-2
  logging in  3-6
  logging in example  3-7
  setting up users  3-12
  testing installation  3-6
  username and password  3-6

WebView system  1-1
  client sizing  1-2
  server sizing  1-2